CONFERENCE POSTERS

Lindsay McNiff
Learning & Instruction Librarian
Agenda

• Why a conference poster?
• Poster conventions
• Making posters
  • How to set up a basic poster in PowerPoint
  • Some tips on font, colours, etc
  • Using images and graphs
• Presenting posters – a few ideas for interactivity
Why a conference poster?

• Alternative to a conference presentation
• Visual communication of scholarly ideas
  • Will you be including a lot of amazing charts?
  • Is your research a work-in-progress?
• Facilitates interaction with other researchers
  • Networking, conversing
• People are more engaged when standing
Poster sessions
Common scientific poster sections

**note that these sections might not be appropriate for your poster!**

- Title
Fun with title creation: https://www.portent.com/tools/title-maker
Common scientific poster sections
**note that these sections might not be appropriate for your poster!**

- Title (catchy, 2 lines max)
- Background (about your topic) \(\equiv\) Abstract.
- Methods (what you did. Consider photos.)
- Results (what you found)
- Discussion/Conclusions (what it means)
- Citations (5-10)
- Acknowledgements

Should be interesting and understandable for laypeople.
Common scientific poster sections
**note that these sections might not be appropriate for your poster!**

• Title (catchy, 2 lines max)
• Background (about your topic) ≠ Abstract
• Methods (what you did. Consider photos.)
• Results (what you found)
• Discussion/Conclusions (what it means)
• Citations (5-10)
• Acknowledgements

Consider other more interesting titles that capture these same ideas
Title: catchy and yet descriptive

“D.I.Y.” – how they did this on the cheap

“Assess” – description, using graphs, of student uptake

“Promo” – how they promoted the service

“Tips” – key takeaways to help others plan similar initiatives
Some “rules”

- Keep it concise – 1000 words or less (5-10 min)
- Background: white or light (or at least contrast)
- Landscape is generally preferred
- Think about your audience when choosing terminology

- Use white space
- Font:
  - Title: 100
  - Section headings: 48
  - Body text: 18 (unjustified margins)
- Embrace logical arrangement
• Images attract the eye
• People read from top to bottom, then left to right (which is why columns are popular for conference posters)

“Eyes followed a common pattern of navigation. The majority of readers entered all pages through the dominant photo or illustration, then traveled to the dominant headline, then to teasers and cutlines, and finally to text.”

http://betterposters.blogspot.ca/2010/10/eye-tracking.html
Why screencasting?
The benefits of interactive online tutorials
Meghan Ecclestone & Angela Hamilton, York University

Introduction

Problem

The traditional information literacy format of in-person lectures and step-by-step exercises is critical to practice and pedagogical functions. Many students have limited access to technology, which means that they are not as likely to utilize the computer at home. For those who do, the content is often not as engaging. In addition, traditional lectures and exercises are often not available in electronic form. This gap in library instruction access has resulted in a need for an alternative method of instruction. Online programs are growing in number and are now becoming an essential part of many students' learning experience due to their limited time constraints.

Objective

We hope that our students can use this tool to fill this gap in our curriculum. By creating interactive online tutorials, we can help students expand their learning opportunities and create a more engaging environment for creating and sharing these resources as part of their information literacy instruction.

Steps in Creating Screencasts

1. Choose your software
   - Think about what you want to do
2. Make a plan
   - Have a story/idea/storyboard
3. Set up
   - Select the technology, set up software, overcoming distractions
4. Practice
   - Learn to use everything and learn to use your computer
5. Record
6. Edit
   - Video editing, add voiceover, etc.
7. Publish
   - Add to a blog, add credits, add content, contact information
8. Distribute and advertise
9. Share
   - Show off your hard work to other professional with tutorial sharing projects such as ATEC, PRRR, LILEC, etc.

Methodology

- We will use the creation of screencasting tools as a method to engage our students.
- We will conduct a review of the library and information literacy literature.
- We will gather feedback from the students to continually improve the tools.

Major Findings

Uses & Software

The use of screencasts is growing significantly within academic libraries. Anderson in 2006 and includes tips on how to add value to specific databases and citation tools, along with software such as Captivate and using library resources. Screencasts are also being used to support distance education (Back, 2006).

There are many tools available to create a screencast if your experience that this form of a tool does improve the ability to create professional looking video tools.

Screencasting Software

- Cambria
- Captivate
- Redboodman
- Carbonite's Viewbuilding
- Screenflow
- Jing (Free)
- Wink (Free)

Benefits and Assessment

Studies in pedagogy and learning styles have long been concluded that oral or text-based learning tools are not as effective for visual-spatial learners (Wwmpson, 2005). Online tutorials allow students to learn in a structured library setting and demonstrate independence. These students can use the library's resources and digital tools to independently create their own unique learning experience. The library is then able to effectively deliver information to students, thereby increasing their learning opportunities and creating a more engaging environment.

Conclusions

Do's

- Use your voice to explain the content
- Make it easy to follow
- Make it interactive
- Include your face\n
Don't's

- Use too much text
- Use too many words
- Use too many words
- Use too many words

References

Pigs in Space: Effect of Zero Gravity and Ad Libitum Feeding on Weight Gain in Cavia Porcellus

Colin B. Purrington
6673 College Avenue, Swarthmore, PA 19081 USA

ABSTRACT:

One ignored benefit of space travel is a potential elimination of obesity, a chronic problem for a growing majority in many parts of the world. In theory, when an individual is in a condition of zero gravity, weight is eliminated. In space, one could consequently take in unlimited food and never gain an ounce, and the only side effect would be the need to upgrade one’s gravity suit (“exercise pants”). But because many dietary schemas start as very good theories only to be found to be either harmful, we tested our predictions with a long-term experiment in a colony of Guinea pigs (Cavia porcellus) maintained in the International Space Station. Individuals were housed separately and given unlimited amounts of high-calorie food pellets. Fresh fruits and vegetables were not available in space or were not offered. Every 30 days, each Guinea pig was weighed. After 5 years, we found that individually, on average, the pigs gained no weight. In addition, we did not observe any significant differences in the protocol. If space continues to be gravity-free, and we believe that assumption is sound, we believe that sending the animals to space could be a viable alternative to dietary intervention and that the risk of overeating would be a non-issue.

INTRODUCTION:

The current obesity epidemic started in the early 1990s with the invention and proliferation of fast-food and fast-food chains. In 2009, the food industry released the food pyramid from the Agricultural Research Service, which replaced the food guide pyramid with a food guide for people to eat less sugar and more fruits and vegetables. A single piece of fruit or vegetable can provide the body with all the necessary nutrients. However, this meal plan is not the only way to eat. In 2010, the International Space Station began to feed animals in space. The animals were given unlimited access to food, and their weight was monitored. Despite this access, the animals lost weight. This experiment was repeated with the same results.

RESULTS:

Mean weight of pigs in space was 0.0000 ± 0.0002 g. Some individuals weighed less than zero; some more, but these variations were due to reaction to the dust tape, which caused the pigs to be distressed. The body weight of the pigs was not statistically significant. However, multiple companies are developing cheap extra-oral travel options for normal consumers, and potential travelers are also creating their own flights. The potential for space tourism to become a reality is not far off.

CONCLUSIONS:

Our view that weight and weight gain would be zero in space was confirmed. Although we have not replicated this experiment on larger animals or primates, we are confident that our result would be mirrored in other model organisms. We are currently in the process of obtaining necessary human trial permissions, and should have our planned experiment initiated within 80 years, pending expedited review by local and federal authorities.

ACKNOWLEDGEMENTS:

I am grateful for generous support from the National Research Foundation, Black Hole Diet Plans, and the High Fructose Sugar Association. Transport rights were funded by SPACE EXES, the corporation of space-discovery and space-flight startups. I am also grateful for comments on early drafts by Martin Athletic Club, Corpus Christi, AUS. Finally, sincere thanks to the Guy Foundation for generously donating animal care after the conclusion of the study.

LITERATURE CITED:

NHLBI 1982. Project STB-105, Guinea Pigs. Lockheed (internal memo).


COMMUNITY ENGAGED SCHOLARSHIP AT LAURIER

What is it?
COMMUNITY ENGAGED SCHOLARSHIP (CES)
"Mutually beneficial partnerships between communities and universities for learning, knowledge co-creation & mobilization."

FACULTY
"CES approach takes time and commitment but it is very rewarding when you see what your students enjoy, learn and apply what they have learned in class while helping members of the community."
Faculty survey says...
- Have time for CES: 62%
- CES is adequately rewarded: 12%
- Would like more support: 42%

Benefits
- Enhances learning
- Connects teaching to everyday life
- Unique research and publications
- Transformational change
- Personal & societal change
- Stronger relationships

Challenges
- Integration of on and off-campus learning
- Time & cost
- Unclear expectations
- Support for students & faculty

Actions
- Reward CES efforts as part of hiring, tenure and promotion
- Coordinate CES efforts among departments
- Match community needs and university resources
- Designate CSL courses on the academic calendar
- Develop policy on CES

STUDENTS
CES Interest by the numbers
- Had they have the time: 58%
- Already doing volunteering: 63%
- Interested in more community-university coursework: 72%
- Willing to pay a small extra fee for a CSL course: 75%

Benefits
- "I've never ever had a placement that didn't change me. I've never went and did a placement where I haven't come out with something."
- 66% of students reported increased leadership skills
- 56% of students reported increased cultural competence

For more info visit: www.wlu.ca/cas/ces

Poster: https://i.pinimg.com/736x/88/db/48/88db480678c6590de1ea5550ac81ca4--cardiff-university-service-learning.jpg
Setting it up: How big?

• Size can depend on conference requirements
• 36 inches high is very standard
• The poster must be created at the same size in which it will be printed
Template or from scratch?

• Lots of templates available
  • http://www.posterpresentations.com/html/free_poster_templates.html
  • http://colinpurrington.com/tips/academic/posterdesign#templates

• Pimp My Poster on Flickr (examples only)
  https://www.flickr.com/groups/pimpmyposter/
Let’s get started!

• Open PowerPoint
• Remove any boxes on your screen
Gridlines are helpful

- Click the **View** tab
- Refer to “Step 1” on handout
- Create a 3-column layout:
Let’s set up our dimensions! Step 2

• Click the **Design** tab

• Click **Slide Size**; open **Custom Slide Size** or **Page Setup** on Mac

• Format like so (48 x 36), landscape (121.92 x 91.44 in cm)
This does not matter. Click either “Maximize” or “Ensure fit.” Do NOT click “Cancel.”

Set your layout to a blank slide: Home tab -> Layout -> Blank
You should have this (tiny boxes on a Mac). If you don’t have this, don’t panic. The gridlines are helpful but not necessary.
Random topic generation time (or not)

• Go to http://ideagenerator.creativitygames.net/ or Google creative idea generator

• Hit the W+ button a maximum of 4 times to create a topic for your poster

Example: How to create garden gnomes out of wine corks

• Of course, you could also use a topic you’re actually working on
Fonts interlude

• Do not use more than 2 fonts
• Debate:
  • Sans for headings; serif for body?
  • Sans for the whole thing?
• Colour: black is usually best for body font
• Titles & headings: **bold.** Not *underlined.* **NOT BOTH.**
• AVOID ALL CAPS
• Size: 100, 48, 18 (MINIMUM)
• Use sentence case for your headings! Try it!
Title case:
From Wine Cork to Garden Gnome: An Exploratory Study

Sentence case:
From wine cork to garden gnome: An exploratory study
Dear Mum,

I Am Going To Leave The Spare Key Under The Flower Pot In The Front Garden So That If You Arrive Before I Get Home From Work You Can Get In. Please Feed Fluffy If She Looks Hungry Or Meows A Lot When You Open The Door. Tuna Is Her Favourite Flavour.

Example from http://www.stickycontent.com/blog/are-you-team-title-case-or-team-sentence-case-case.php
Let’s give this thing a title!

Step 4

• Add a text box across the top (Insert tab -> Text box )

• In 100 point (your choice of font), create a title

• Add your name & affiliation, slightly smaller, underneath the title

• Change the weight of the line around the box
  • Click on the box
  • Click Format (or Shape Format) tab
  • Open Shape Outline menu and choose the weight

• Change the shape of your text box if you want
  • Click on the box
  • Click Format (or Shape Format) tab
  • Open Edit Shape menu and select your shape (rounded box?)
Let’s create some boxes!

• Using your columns as a guideline, create text boxes with headings (60 point font) for some of the following sections (or sections appropriate to your topic):
  • Background
  • Methodology
  • Results (largest section)
  • Discussion
  • References
  • Acknowledgements

• Insert dummy text at 36 point in some of the boxes

- Use the Text Box function or the Shape function.
- Choose the weight of the lines
- Choose the shape (ie. Rounded corners or square?)
- Don’t worry about colour yet
Colour scheme

- Online colour wheels are your friend
- Try Adobe Kuler
- Browse colour schemes or create your own
Let’s colour it!

From wine cork to garden gnome: An exploratory study

Lindsay McNiff, Dalhousie University

Background

Methods

Results

Discussion

References

Acknowledgements
Images

- Images should be **meaningful**
- Should be at least 50k in size, which web images are often not
- Add a thin grey or black border to photographs on your poster
- Set up PowerPoint to avoid compressing images (not available on Mac)
  - File -> Options -> Advanced. Check Do **not** compress images in file.
- Material with permissive licenses:
  - Google Image search – Use “Tools” function to filter by license
  - thenounproject.com
  - iconfinder.com
  - [http://commons.wikimedia.org/wiki/Main_Page](http://commons.wikimedia.org/wiki/Main_Page)
  - search.creativecommons.org
- Caption your images
University logo

• You may want to include one

• http://www.dal.ca/dept/communicationsandmarketing/tools-and-resources/downloads/logos.html - use .png
“Unlike boring institutional logos, adding a research-related image to the top of a poster can draw in visitors.”
– C. Purrington

Image: https://colinpurrington.com/tips/poster-design/protips
Graphs

- Graphs & charts should be created in Excel and then copied into PowerPoint
- Excel templates are available
- Check out Watch Your Figures for a run-down of which types of graphs are best suited to which types of information
- Infographics
  - Easel.ly
  - Piktochart
  - Infogr.am
- Word clouds
  - http://www.wordle.net/
Take a minute

• Add the Dal logo to your poster


• Try adding the following:
  • At least one 50k or higher photo with a permissive license
  • One of the sample graphs (copy/paste) from the Google Doc (*Bonus: adjust the colours on the graph to fit your scheme)
From wine cork to garden gnome: An exploratory study

Lindsay McNiff, Dalhousie University

Background


Discussion


Results


Methods


References


Acknowledgements

Finish it off!

- Remove the gridlines
- Save it as a PDF
- And...
From wine cork to garden gnome: An exploratory study

Lindsay McNiff, Dalhousie University

Background


Discussion


Results


Methods


References


Acknowledgements

Printing the poster

- Make sure you have saved it as a PDF
- Matte or Satin
- Printers vary on how high they can print
  - Dal Print Centre = 24 inches
  - Killam Learning Commons = 36 inches
- Killam: prints Mon-Fri, 24 hour turnaround, $10 per linear foot
  satin, $9 matte (so, $36-$40). Fill out the request form:
  https://util.library.dal.ca/PosterPrinting/
- Get a tube
Presenting your poster

• Prepare a 2-minute lightning talk
• If more listeners arrive mid-way through, don’t start again
• Candy is a great idea
• Ask your friends to hang around
• Bring double-sided handouts
  • Copy of your poster on one side
  • Complete bibliography and further information on other side
  • Put your poster online and create a short link for viewers to photograph
• Bring business cards (a name tag is also a good idea)
Consider interactivity

- Create comment cards or a feedback sheet
- Try lift-up flaps (especially when only some of your audience will find the info under the flap interesting.
- Make a 3D model (if it makes sense)
- Allow others to contribute to your poster (sticky notes? Whiteboard?)
- Bring an iPad (or embed it in your poster) or laptop
- Make it easy for others to leave business cards
Remember...

“Data” is a plural word.
The data *is* not compelling.
The data *are* compelling
QUESTIONS?
Resources consulted


• Adam Reed, Producing an Academic Poster https://www.youtube.com/watch?v=GJwcVWsLC4

• Chris Woolston: Conference presentations: Lead the poster parade http://www.nature.com/nature/journal/v536/n7614/full/nj7614-115a.html

• Colin Purrington: http://colinpurrington.com/tips/academic/posterdesign

• How to create a poster in PowerPoint for a poster conference (MAC or PC) - https://www.youtube.com/watch?v=mCJ71rISBcA UH Manoa LIS Web Team

• Inspired by “Posters with Punch Using PowerPoint” – workshop at U of T; Karen Smith, ginger coons